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Next meeting: WEDNESDAY, March 13th, 2002

CLUB NEWS

The Year in Review by Chris Taylor

W
e had quite an eclectic set of topics for our general

meetings in 2001. We started of the year with a

presentation by OPCUG members on security and your

home computer. February saw Corel coming out to demo the latest

release of their venerable graphics program, DRAW 10. In March we

had a presentation on how to do effective peer-to-peer collaboration

over the Internet. In April, Ron Thompson from Information

Technology Security Inc. gave us the low-down on the new “Personal

Information Electronic Documents Protection Act.” In May we had

another OPCUG member presentation, this time a double-header on a

user’s perspective on a couple of commercial programs – VMWare and

Office XP. Olympus came out to show us the latest technology in

digital cameras in June.

After the summer break we had Microsoft come by and show us the

nifty new features in Office XP. When Microsoft was unable to come

out at the last minute in November for a planned Windows XP demo,

we had out third member presentation for the year – all about the

options for setting up a home network. In November, we had J-Squared

Technologies come out and talk to us about AMD processors and how

they compare with Intel chips. We rounded out the year in December

with a presentation by Bloom Microtech. I hope they helped people

decide on some last minute holiday presents.

Many thanks to all those who came out to give us some terrific

presentations.

In non-meeting-topic news, in January we launched the sale of mugs

and multi-tools sporting the OPCUG logo. One of the purposes of

buying a supply of these goodies was to have them to present to

speakers as a token of gratitude, but many members have found them a

worthwhile purchase as well. There are lots still available for anyone

interested - $15 per mug and $20 per multi-tool.

In February, we saw an influx of new members as the Helpful User

Group of Ottawa folded up shop as a separate entity and their

remaining members joined the OPCUG.
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In March we launched the highly successful

“Orphans SIG”. The coordinator, Henry Sims,

had seen a need for a more focussed SIG that

could deal at a beginner level in more depth

on specific topics. Attendance at Orphans SIG

meetings has remained high since the launch.

In October, we lost the use of the domain

name opcug.ottawa.com briefly when Southam

(who own the ottawa.com domain) were doing

a cleanup and unceremoniously removed our

sub-domain. We got it back temporarily, and

we obtained the opcug.ca domain name so it

doesn’t happen to us again.

continued page 2

Club members enjoy a presentation

at one of our monthly meetings.
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CALENDAR

Meetings Date Time and venue

OPCUG General Meeting Wednesday, March 15th 7:30 p.m. Auditorium of the National Museum of Science and

Technology, 1867 St. Laurent Blvd.

Internet SIG (I-SIG) Wednesday, March 15th Come and join our discussions!

Developers SIG Wednesday, March 15th Immediately following the main OPCUG presentation, and

occasionally at other locations in the region.

Delphi User Group TBA 8:00 p.m. at Chapters Store in the Pinecrest Mall (at the Queensway)

Ottawa Paradox Users Group 3rd Thursday each month 6:00-8:00 p.m. — Corel Bldg 1600 Carling Ave

Please note that unless otherwise noted, SIGs meet at 9:00 p.m. (immediately following the OPCUG General Meeting).

CLUB NEWS

Coming Up
in March
Eurocom will be coming to the OPCUG

March 13 (yes, we’re back to the second

Wednesday of the month again). Eurocom

will be demonstrating their all-new P4

laptops.

✧✧✧

Also in October, through the efforts of long-time member

David Reeves, we launched the “Member Services” conference area

and corresponding list on the listserver. Through this new venue,

members may advertise services they would like to make available to

other members. Anyone is also free to solicit services through

“Member Services”

Raffles remained popular throughout the year and have managed to

raise $1,021 in 2001. All of this was pure profit for the OPCUG due to

the generosity of vendors, who donated the prizes. Many thanks to

those vendors and to the folks who bought raffle tickets.

✧✧✧

The Year in Review ...continued from page 1

Eenie Weenie Bit by Timothy Mahoney, OPCUG Meeting Co-ordinator

“ I don't want much, I just want a little bit,

I don't want it all, I just want a little bit,

Just an eenie weenie bit, teenie weenie bit ...”

— Johnny Winter

A
irport security has been beefed up all over,

and many high-tech companies

approached about doing presentations to

the OPCUG often mention how difficult and time

consuming it has become to travel anywhere to do

marketing presentations.

Many firms have closed their local offices in

Ottawa and have moved back to operate from

their head offices which are usually situated in

the United States somewhere. If they are able to

come, they are often unable to commit until the

last moment when our publication and media

deadlines have all passed.

Some companies, believe it or not, even suggest having OPCUG

members go to Websites and download demos etc... mostly the big

companies with large market portions. Not very useful for the

purpose of wanting a speaker.

Things sure have changed over the last few of years. I can remember

a time when companies used to go crazy wanting the opportunity to

present to a group of people. Now its “come visit our Website at

WWW...”, with no faces, and no interaction.

This poses quite a challenge in finding presenters for the group each

month. So I'm asking for “just an eenie weenie bit, a teenie weenie

bit” of your help in finding topics and speakers for our meetings.

Any topic suggestions, ideas, companies, or people you know of who

might be of interest, or interested in the opportunity of doing a

presentation to the OPCUG, please let me know or encourage them to

get in touch with me. If it sounds good, I'll gladly make the

arrangements.

✧✧✧



March 2002 Ottawa PC User's Group 3

WINDOWS TROUBLESHOOTING

Windows Rogues by Dunc Petrie

H
ave you ever installed a demo or an application only to

sincerely regret it? In my never-ending quest to wrap myself,

or at least my computer, up in knots I relate the following true

exercise in frustration. The name of the application shall remain

anonymous: let’s just call it ‘The Demo’. I installed it without any

problem and it performed well. Nothing during either the installation or

the trial suggested that it would wage an unrelenting war to prevent its

removal - strange since it had time-expired once I finally eliminated it.

Author’s qualifier
Some of the procedures described are not for the faint-of-heart. Make

sure that you have made, as a minimum, backups of key files (for

example, the Registry). Better would be a full system backup (tape,

CD-R) or an image (using a program like Norton/Symantec’s Ghost or

PowerQuest’s Drive Image). Do as I say and not as I have done (later

in this article). You have been warned! I have also omitted some of

the specific steps to create various values within the Registry to save

some space.

The system
I was using a Pentium II 266 MHz running Windows 2000 that my son

used for his college work. He decided to upgrade to a faster machine

and Windows XP (the joy of learning with academic prices). Here was

my opportunity to experiment with Windows 2000! As a ‘Win Niner’

I was seduced by Windows 2000 promises of no more BsoD (Blue

Screen of Death), no memory leakage and Chris Taylor’s tales of

running 24 hours a day for months without rebooting. Until I installed

this demo, Windows 2000 lived up to its promise.

The problem
Every time the machine was booted (cold boot), restarted (warm boot)

or an application was launched, up popped the dialog box for Windows

Installer. Whether I logged on as Administrator or as a User made no

difference. Now, nothing was ever installed; the dialog box just stayed

on-screen for awhile making a nuisance of itself and blocked any

keyboard or mouse activity in the interval while I fumed. Some

instances seemed particularly refractory; for unknown reasons Internet

Explorer (Version 5.50) seemed a favorite. For these, I had to resort to

the Task Manager to shut down the Installer.

I suppose that I could have endured this minor irritation being too lazy

to follow my own advice and: “Delete, reformat and install a backup.”

Two complications: first, the truth was that I had not yet obeyed my

own maxim and performed a system backup. Worse, ‘The Demo’ took

perverse pleasure in popping up at the most inopportune time: during

the creation (‘burn’) of a CD-R. The first time I put it down to one of

life’s little glitches since I had not seen the culprit in action before.

The next time I rechecked all the options for

the burner software and kept an eye on the

screen. What’s this? What the $%&^& is

Windows Installer doing? No, my CD burner

does not employ buffer under-run protection.

Initial approaches
Regretting my stupidity of no backup and

thinking that I could save time I decided that I

would try to fix it (by now, I’m sure that you

are laughing). At this point I had no idea of

the source of the problem: the Windows

Installer never named its client. First, I looked

at the Processes (Ctrl+Alt+Del, select Task

Manager and select Processes tab) but nothing

showed despite the presence of the installer on

the Task Manager’s application tab.

Stumped, I looked around on the Internet and

got a few tips. One suggestion: make certain

that ‘Automatically check for IE updates’ was

deactivated (unchecked) on Internet Explorer’s

Tools... Internet Options... Advanced tab.

Otherwise, Internet Explorer would try to force

an upgrade to Version 6 - using Windows

Installer. If true, perhaps my cable/DSL

router was preventing a ‘natural’ (according

to Microsoft) process. I verified that the box

was unchecked. Scratch one!

Another suggestion achieved real progress.

The Microsoft Windows Installer (MSI)

includes an auto repair module. In case a file

is damaged (or MSI believes that it is

damaged) MSI will attempt an automatic

repair/workaround.

When attempting to diagnose a problem an

automatic mode is too obscure; instead, in

‘Microsoftese command syntax’ it must

become ‘verbose’ and report its findings by

creating a log file (When DOS was paramount

reporting often occurred on-screen; you

know, those lines of text that flashed by so

fast that they were impossible to read). My

Internet collaborator suggested that I edit the

Registry. Well, what the heck, go without a
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backup; live dangerously; go for broke. Log in as Administrator. Call

RegEdit. Navigate to the Registry key:

HKEY_LOCAL_MACHINE\Software\Policies\Microsoft\Windows\In

staller.

Next, create the string value (the Registry will identify it as a

REG_SZ) and name it “Logging” (lose the quotes).

Set its value to be “iwearucmopv” (again, lose the quotes). Each letter

covers one ‘type’: for example, i=status, w=warning, e=error [edited

for space]. Restart your machine. Every time MSI is activated, it will

generate a .log file.

The file name mask will be MSIxyza.log, MSIxyzb.log where the

characters ‘x’, ‘y’, and ‘z’ are variable and the final letter of the

filename (‘a’, ‘b’ , et cetera) is sequential. These are text files;

Windows will use NotePad as the default application to view them.

They will be held in the designated system temporary folder (for my

system, C:\WINNT\Temp). The .log file should contain the name of

the offender, in this instance:

Error 1706.No valid source could be found for product [name].

The Windows Installer cannot continue.

=== Logging stopped: 01/19/2002 13:54:07.

Once I determined the guilty application I intended to use the

Add/Remove Programs applet in Control Panel. Surprise: this applet

reported that the installation had been ‘defective’ (no additional

information) and the application could not be removed using

Add/Remove Programs.

Now, I’m mad
Time to get mean. Using RegEdit I searched

the Registry for all occurrences of the

application’s name and the name of the

software company. The number of entries

was amazing and they were scattered

throughout the Registry. Once located, they

were deleted. Then, I deleted the folder that

held the program and its links in Start...

Programs. I checked the contents of the

most likely .ini files (including Win.ini and

System.ini) without finding any references.

Great plan I thought while the machine

rebooted... but - reality check - the

Windows Installer dialog box has won again. I examined the most

recent .log file and the error message was word-for-word the same.

Using Event Viewer (Control Panel... Administrative Tools... Event

Viewer... Application Log) I located more entries by right-clicking (or

use Action... Properties) on any event which had ‘MsInstaller’

identified as its source.

The Properties dialog box contains a

description box with alpha- numeric strings

that identify the product and/or its

components. I cut and pasted these string

values into RegEdit’s Find (Edit... Find)

function and deleted them.

Where I should have started
Surely, ‘The Demo’ has gone... but, alas!

Apparently corrupt installations or

un-installations create results that do not obey

the rules. When all else fails, ask - back to the

Internet. Someone who had earlier faced the

same problem referred me to Microsoft’s

obscure Installer Cleanup Utility:

http://support.microsoft.com/default.aspx?sci

d=kb;EN-US;q238413.

This utility was originally intended to deal

with problem installations of Microsoft

Office 2000 components although the above

website lists most of Microsoft’s productivity

applications. In fact, the application itself

does not seem to matter; the criterion for

success is the use by the rogue application of

MSI for its original installation. The utility is

intended to remove system settings for the

errant application; it is not intended to

remove MSI itself.

Download the appropriate version:

Msicuu.exe for WinNT/2000 (Msicu.exe for

Win9x). Install it on your system and run it

from the Start... Programs (Windows 2000

requires Administrator privileges). A warning

dialog box will appear: “Continuing... will

make permanent changes to your system.

You may need to reinstall some or all of the

applications... that used Windows Installer...

Selecting Remove will make the changes

permanent. The dialog box lists all programs

that are installed on your computer that use

Windows Installer.” Since the Windows

Installer CleanUp Utility also uses Windows

Installer, it will be listed in this dialog box;

do not delete it. Select the program(s) you

want to remove and follow the directions.

Rebooted... success! The Windows Installer

dialog box no longer appears.

Windows Rogues ...continued
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Windows Rogues ...continued

continued page 6

Conclusion
What a nifty utility! It’s too bad that

Microsoft does not include gems like this in

the default installation of Windows

(particularly Windows 2000 Administrative

Tools). Like TweakUI, Microsoft offers this

utility “as is”; presumably meaning if things

go wrong then don’t call Microsoft. Since

Windows Installer is the de facto choice for

many applications (not only Microsoft’s but

also many third party software offerings) it is

curious that Microsoft is so reluctant to offer

a graceful exit, at least from its own software,

in case things go wrong. After all, Microsoft

insists that third party software includes an

un-install option before Microsoft grants its

official seal of Windows compatibility. Oh

yes, be certain to backup, backup, backup.

✧✧✧

SOFTWARE REVIEW

IRFANVIEW32 Graphics
Utility by Dave Burnside

I
f, like me, you own a digital camera and/or scan pictures and save

them on your computer, you need a graphics program to access and

work with your pictures. One of the best and simplest graphics

utilities I’ve ever come across, and my personal favorite, is a product

called Irfanview32. And it’s also a freeware program for individual use.

Irfanview32 supports multiple image formats. It also has many

different functions for basic and advanced users. Here is a screen

capture of a picture showing the Irfanview32 window.

Of the multiple functions available, the following are the functions I

use most often:

Viewing images: You can use Irfanview32 to Open an image file or if

you associated the image extensions with Irfanview32 during

installation (or from the Options menu), you can simply double-click

the filename in your Windows Explorer. Once an image is loaded,

hitting the ENTER key will make the image full screen. You can then

scroll through all the pictures in the folder using the right mouse button

to advance forward or the left mouse button to return backwards. You

can also use the spacebar to advance through the pictures in the folder.

During viewing (full screen or not), you can zoom in or out using the

View menu or the + or - keys.

Thumbnails: While viewing an image, pressing the “T” or using the

File menu allows you to see thumbnails (small versions) of all the

images in the folder using a file manager like interface.

Rotating images: When I take pictures vertically with my digital

camera, they are saved such that they initially show laying

horizontally. Once a picture is opened, it can be rotated left, right, or

flipped vertically or horizontally using the Image menu or using the

shortcut keys L, R, V or H. The rotated picture can then be saved as a

new file or overwriting the old file.

Croping images: In some cases I’m only interested in a portion of the

picture. I can use Irfanview32 to mark the area I want by clicking on

one extremity and dragging the box over the area I’m interested in.

Then I use the Edit menu to Crop (cut out) the portion I marked. I can

the save the crop as a new file or overwrite the original file.

Batch file renaming: Another extremely useful function is the Batch

file renaming capability. Digital cameras name image files using the

same filename and adding a numeral to distinguish the files (ex.

Image001.jpg, image002.jpg, etc.). In the File menu, you have a Batch

Rename function. You can add all files in a folder or just selected files.

You can then provide a meaningful filename template (ex. Geese

CLUB NEWS

Membership contest
Bring a guest to OPCUG!

by Bob Gowan

A
ll club members are encouraged to

bring along a guest to any of our

meetings and SIGs. Not only will

you be contributing to making your club's

meetings more successful, you could

actually win something for doing so!

This year's membership drive contest will

cover guests you bring to the April and

May general meetings and winners will

be announced at our June meeting.

Watch for full contest details in the next

issue of this newsletter.

✧✧✧
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Irfanview ...continued

Nov00_###) and Irfanview32 will rename all

the files to the template name. The ### adds

an incrementing numeral to the template (ex.

Geese Nov00_001.jpg, Geese

Nov00_002.jpg, etc.). You can choose to

rename the existing files or copy them to new

files, keeping the originals.

Batch file conversions: Similarly, all the files

in a folder can be automatically converted to

another image format. This function works

along the same lines as batch file renaming.

Image resizing: Images can be resized using

a variety of options and a variety of filters.

Slideshow: I used the Slideshow function

under the File menu to create a slideshow of

several thousand pictures we had taken. I then

ran the slideshow with auto scrolling set at 10

seconds and ported the output through my video card TV Out port to

our VCR where I taped the output. The tape was sent to our daughter

in Alberta who doesn’t have a computer.

Irfanview32 even has functions for sharpening colors, enhancing the

images, adding effects etc. It also allows viewing of multi-page

images.

Overall, this free product is great and simple to use for the novice. But

it has a multitude of features that even an advanced user would find

useful.

Irfanview32’s home page is located at:

http://www.ryansimmons.com/users/irfanview/english.htm

I recommend you download both the Irfanview32 utility and the

add-on plugins. Install the utility first and then the add-ons. Personally

I use the images only associations when installing Irfanview32.

✧✧✧

Irfanview32’s user interface - goose those graphics!
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SOFTWARE REVIEW

Drive Image v.5.0 by Harald Freise

O
ne of the things that one always has to

think about when making a decision is

“Do I really need to do this?” Drive

Image is one of those things that falls into this

category. There are lots of utilities that can

make an image of a hard drive. Some of them

are free. Why would you want to do that?

First let me ask… when was the last time that

you backed up your hard disk? Do you trust

applications loading on your machine after

you’ve finally tweaked it enough to be stable?

How long would it take you to be up and

running again if your machine took a software

dive into the big blue screen?

Drive Image has been around for a while and

can make your life a lot easier. Generally

regarded as one of the better disaster, backup

and upgrade utilities this new version adds

upgrades to the previous version.

QuickImage – simplifies the process of

backing up and restoring images by being

able to schedule them automatically from

within windows. Set the parameters and let

the utility back up or restore any drive.

CD-R and CD-RW support is great as a

backup medium. The cost of CD-R has

plummeted to about 50 cents each and is a

great way of backing up and restoring IDE,

SCSI and PCMCIA drives. PowerQuest

claims improved speed in version 5 but I

really can’t confirm that but it does handle

drives up to 80GB.

Drive Image File Editor has been renamed to

ImageExplorer complete with an enhanced

interface that is great for extracting individual

files and copying image partitions to another

PQI DriveImage file.

You can boot directly from the CD-ROM

providing that your BIOS supports that

feature. It will handle FAT, FAT32, NTFS,

HPFS Linux EXT2 and Linux swap file

systems. It supports UNIX and NetWare by

sector by sector support. Using

PartitionMagic’s SmartSector imaging

technology unfortunately does not make a complete duplicate image as

it does not bother to image unallocated disk space.

Drive image still works in DOS if all else should fail and supports

installation from Windows 9x through to Windows XP. Rescue

diskettes can be created under Win95 or newer. The first rescue disk is

actually a Caldera DOS boot disk and the second disk includes the

Drive Image Program. The usual caveats apply about Caldera DOS not

recognizing any disk or partition beyond 1024 cylinders. A work

around for this is by using a Win95/98 standard boot disk in place of

the one created by Drive Image.

When was the last time that you

backed up your hard disk?

Do you trust applications loading on your machine

after you’ve finally tweaked it enough to be stable?

How long would it take you to be up and running again if

your machine took a software dive into the big blue screen?

One of the more interesting new add-ins is VF Editor. This utility lets

one edit the files included on the virtual disk to create a customized

boot disk. Too bad that this only works with the Caldera DOS boot

disk as it really limits it’s usefulness on larger hard drives.

If you are using FAT, FAT32 or NTFS then the included backup utility

Datakeeper might be a backup solution for you. It provides you with a

secure automated backup of your hard disk, a partition that has an

assigned drive letter r a network drive. You can back up any files or

folders on to any other drive or external media such as a LS-120, Jazz,

ZIP or external drive assigned a drive letter to any other recordable

drive available. It supports file compression to save disk space and

password protection. What makes it even more useful is that you can

even restore a single file, by date if you wish, from a compressed

backup volume catalogue. Restoring files or backup is very intuitive as

it follows the windows explorer type interface.

Drive Image and the included utilities are easy to use and quite

intuitive with well placed descriptions and explanations. The manual is

easy to follow and well organized. There is a quick reference sheet for

those that hate to RTFM (Read The Fine Manual) .

✧✧✧
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OTTAWA PC NEWS

Ottawa PC News is the newsletter of the
Ottawa PC Users’ Group (OPCUG), and is
published monthly except in July and
August. The opinions expressed in this
newsletter may not necessarily represent the
views of the club or its members.

Member participation is encouraged! If you would like to contribute
an article to Ottawa PC News, please submit it to the newsletter
editor (contact info below). Deadline for submissions is three
Saturdays before the next General Meeting.

Group Meetings
OPCUG meets on the second Wednesday in the month, except July
and August, at the Canada Science and Technology Museum, 1867
St. Laurent Blvd, Ottawa. Meetings are 7:30–9:00 p.m. and Special
Interest Groups go until 10 p.m.

Fees
OPCUG annual membership: $25 per year.

Mailing Address
3 Thatcher St., Nepean, Ontario, K2G 1S6

Web address
Http://opcug.ca/

Bulletin board—the PUB II (BBS)
Up to 33.6 kbps V.34 . . . . . . . . . . . . . . . . . . . . . . . . . . . 228-8951

Chairman and System Administrator
Chris Taylor ctaylor@nrcan.gc.ca . . . . . . . . . . . . . 727-5453

Meeting Coordinator
Tim Mahoney timothyr@cyberus.ca . . . . . . . . . . . 225-2630

Treasurer
Vince Pizzamiglio vince@monisys.ca

Webmaster
Brigitte Lord opcug@iname.com

Secretary
(Mr.) Jocelyn Doire Jocelyn.Doire@opcug.ca

Membership Chairman
Mark Cayer Mark.Cayer@StatCan.Ca . . . . . . . . . 823-0354

Newsletter
Bert Schopf (editor) bert@blackbirdpcd.com . . . . . 232-8427
(Mr.) Jocelyn Doire (distributor, electronic version):

Jocelyn.Doire@opcug.ca

Public Relations
Morris Turpin morris.turpin@rogers.com. . . . . . . . 729-6955

Facilities
Bob Walker skywalk@iname.com. . . . . . . . . . . . . 489-2084

Beginners’ and Windows SIG coordinator
Duncan Petrie petried@onebox.com . . . . . . . . . . . . 841-6119

Internet SIG coordinator
Norm Dafoe ndafoe@sirius.ca

Paradox SIG coordinator
John Ladds laddsj@statcan.ca . . . . . . . . . . . . . . . 951-4581

Delphi SIG coordinator
Stan Isbrandt isbrandt@trytel.com . . . 992-8141 / 729-7793

Orphan SIG coordinator
Henry Sims ha4326@rogers.com

Developers’ SIG
Bob Thomas BobThomas@msn.com

© OPCUG 2001. Reprint permission is granted* to non-profit
organizations, provided credit is given to the author and The Ottawa

PC News. OPCUG requests a copy of the newsletter in which
reprints appear. *Permission is granted only for articles written by
OPCUG members, and which are not copyrighted by the author.

CLUB LIFE

Reduce, Reuse,
Recycle
Bring your old computer books, software,

hardware, and paraphenalia you want to

GIVE AWAY to the General Meetings,

and leave them at the table near the

auditorium’s entrance. Please limit

magazines to publication dates of less than two years old.

You may TAKE AWAY any items of use to you. Stuff left

over at the end of the meeting will be sent to the recycle bin.

✧✧✧

CLUB NEWS

OPCUG 2001
Balance Sheet
by Vince Pizzamiglio, OPCUG Treasurer

Revenues

Membership 4650.00

Raffle 1021.00

Mugs/Tools 405.00

Interests 309.36

Total 6800.63

Expenses

Newsletter 3007.27

ASDL/Bell 1251.44

Tools/Mugs 1478.47

Equipment 184.74

Bank fees 56.33

Total 5978.25

Operating Surplus 822.38

Dec. 31, 2001

Royal Bank account 1975.04

ING 12036.38

Total cash 14011.42

Jan. 1, 2001

Royal Bank account 5689.04

GIC 7500.00

Total cash 13189.04

✧✧✧


